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Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using the 
PIC24FJ256DA210 Development Board. Items discussed in this chapter include:

• Document Layout

• Conventions Used in this Guide

• Recommended Reading

• The Microchip Web Site

• Training and Seminars

• Development Systems Customer Change Notification Service

• Customer Support

• Document Revision History

DOCUMENT LAYOUT 

This document describes how to use the PIC24FJ256DA210 Development Board as a 

development tool to emulate and debug firmware on a target board. The manual layout 

is as follows: 

• Chapter 1. Introducing the Development Board provides a brief overview of the 
PIC24FJ256DA210 Development Board, its features and its uses.

• Chapter 2. The Demonstration Application provides a brief overview of the 
interactive, touch-screen-based demo that ships with the development board.

• Chapter 3. Programming and Debugging the Board provides instructions for 
using MBLAB® IDE to create a project and program the development board.

• Chapter 4. Development Board Hardware provides a detailed description of the 
development board’s features and instructions on their configuration.

• Appendix A. Development Board Schematics provides the schematics and 
other technical details. 

• Appendix B. Modifications for PICtail Plus Daughter Boards provides specific 
directions for adapting the development board to interface with daughter boards. 

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help. 
Select the Help menu, and then Topics to open a list of available on-line help files.
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 

dialog

“Save project before build”

Underlined, italic text with 

right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 

any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 

character: { | }

Choice of mutually exclusive 

arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 

user

void main (void)
{ ...
}
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RECOMMENDED READING

This user's guide describes how to use PIC24FJ256DA210 Development Board. Other 

useful documents are listed below. The following Microchip documents are available 

and recommended as supplemental reference resources.

PIC24FJ256DA210 Data Sheet (DS39969)

Consult this document for detailed information on the PIC24FJ256DA210 microcon-

troller with integrated graphics controller. Reference information found in this data 

sheet includes:

• Device memory map

• Device pinout and packaging details

• Device electrical specifications

• List of peripherals included on the device

PIC24F Family Reference Manual

This reference manual explains the operation of the PIC24F microcontroller family 

architecture and peripheral modules. The specifics of each device family are discussed 

in the individual family’s device data sheet. This useful manual is online located in the 

Technical Documentation section of the Microchip web site. Refer to these for detailed 

information on PIC24F device operation.

MPLAB® ASM30, MPLAB® LINK30 and Utilities User’s Guide (DS51317)

This document helps you use Microchip’s language tools for PIC24F devices based on 

GNU technology. The language tools discussed are the MPLAB ASM30 Assembler, 

MPLAB LINK30 Linker, MPLAB LIB30 Archiver/Librarian and other 16-bit device utili-

ties.

MPLAB® C30 C Compiler User’s Guide (DS51284)

This document helps you use Microchip’s MPLAB C30 C compiler to develop your 

application. MPLAB C30 is a GNU-based language tool, based on source code from 

the Free Software Foundation (FSF). For more information about FSF, see 

www.fsf.org.

MPLAB® IDE User’s Guide (DS51519)

This document describes how to use the MPLAB Integrated Development Environment 

(IDE), as well as the MPLAB IDE Project Manager, MPLAB IDE Editor and MPLAB SIM 

Simulator. Use these development tools to help you develop and debug application 

code.

MPLAB® IDE Simulator, Editor User’s Guide (DS51025)

Consult this document for more information pertaining to the installation and implemen-

tation of the MPLAB IDE software.

Graphics Solutions and Capacitive mTouch™ Sensing Documentation

The Microchip web site provides a wealth of information for developing microcon-

troller-based solutions using graphics and touch sensing. Application notes and soft-

ware libraries are available to help design and implement applications. Refer to 

www.microchip.com/graphics and www.microchip.com/mtouch for more information.



PIC24FJ256DA210 Development Board User’s Guide

DS51911A-page 8  2010 Microchip Technology Inc.

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 

site is used as a means to make files and information easily available to customers. 

Accessible by using your favorite Internet browser, the web site contains the following 

information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Application and Market Support – Specific information on Microchip’s latest 
solutions for targeted vertical markets and hardware solutions, including 
ready-to-use application libraries to support the latest hardware

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

TRAINING AND SEMINARS 

Microchip offers classes and training in Regional Training Centers (RTCs) conveniently 

located worldwide. The RTCs offer a variety of highly-targeted design topics that can 

help in creating new applications, adding functionality to existing applications, or taking 

full advantage of new and unfamiliar device peripherals on PIC devices and dsPIC® 

DSCs. These classes can help in keeping current in the competitive and always chang-

ing world of embedded design, and stay ahead of industry trends and design tech-

niques. Visit the RTC web site at www.microchip.com/rtc site for details on offered 

classes.

In addition, Microchip also offers various a wide-ranging line of online webinars that are 

available at all times. For those users who may not have the ability to attend a class in 

person, or the time to wait for a class to be offered, these provide a convenient alter-

native that is available on your schedule. For more information, visit the web sites 

www.microchip.com/webinars. 
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DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 

products. Subscribers will receive e-mail notification whenever there are changes, 

updates, revisions or errata related to a specified product family or development tool of 

interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 

Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers and other language 
tools. These include the MPLAB C18 and MPLAB C30 C compilers; MPASM™ 
and MPLAB ASM30 assemblers; MPLINK™ and MPLAB LINK30 object linkers; 
and MPLIB™ and MPLAB LIB30 object librarians.

• Emulators – The latest information on Microchip in-circuit emulators, such as the 
MPLAB ICE 4000.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debuggers, MPLAB ICD 3 and MPLAB REAL ICE.

• MPLAB® IDE – The latest information on Microchip MPLAB IDE, the Windows® 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB SIM simulator, MPLAB IDE Project Manager 
and general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
the MPLAB PM3 and PRO MATE II device programmers and the PICSTART® 
Plus, PICkit™ 3, MPLAB ICD 3 and MPLAB REAL ICE™ development 
programmers.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 

(FAE) for support. Local sales offices are also available to help customers. A listing of 

sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

DOCUMENT REVISION HISTORY

Revision A (June 2010)

• Initial Release of this Document.
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Chapter 1.  Introducing the Development Board

1.1 INTRODUCTION

The PIC24FJ256DA210 Development Board is an efficient, low-cost development plat-

form to evaluate the features and performance of Microchip’s PIC24FJ256DA210 

microcontroller. The 16-bit microcontroller integrates a high-performance graphics con-

troller, CTMU and USB OTG modules essential for integrated human interface applica-

tions. Supporting this is a range of user-defined interfaces, USB options and memory 

expansions for the maximum flexibility in developing graphics-capable solutions. A 

range of Microchip development tools and software environments, along with a range 

of application libraries, simplifies the process of software development.

Topics discussed in this chapter include:

• Development Board Features

• Power Requirements

• Companion Display Panels

• Typical Development Board Configurations

• Development Board Demonstration Programs

• Additional Software for Application Development 

1.2 DEVELOPMENT BOARD FEATURES

The PIC24FJ256DA210 Development Board, shown in Figure 1-1, incorporates a 

range of features to enhance its usefulness as a platform for developing graphics 

applications. Key features are identified in Figure 1-2.

FIGURE 1-1: PIC24FJ256DA210 DEVELOPMENT BOARD
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FIGURE 1-2: PIC24FJ256DA210 DEVELOPMENT BOARD LAYOUT

1. PIC24FJ256DA210 Microcontroller (U2)

2. Potentiometer for analog input (R3)

3. Prototyping area

4. Three red user-defined LEDs, multiplexed with (8) and (9) (D1, D2 and D3)

5. Red user-defined LED on PMA17 address line (D4)

6. MCLR Reset Button (S4)

7. Microchip Display Connector V1 (J3)

8. Capacitive touch pads

9. Push button switches (S1, S2 and S3)

10. On-board 512 Kbyte SRAM (U6)

11. On-board 512 Kbyte Flash Memory (U5)

12. On-board 16 Mbit (2 Mbyte) SPI Flash Memory (U4)

13. PICtail™ Plus 120-pin expansion connector (J8)

14. On board 5V and 3.3V regulators for external 9V input (Q1 and Q2), and green 

LED power indicator (D6)

15. USB device mode interface (J2)

16. USB Host mode interface (J4)

17. USB On-The-Go mode interface (J7)

18. RS-232 (DB-9F) serial port and associated hardware (P1)

19. RJ-11 ICD programming/debugging connector (J10)

20. PICkit™ ICSP™ programming/debugging connector (J9)

21. 32.72 kHz secondary oscillator circuit (Y2 and U1)

22. 8 MHz crystal for primary microcontroller clock (Y1)
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1.2.1 PIC24FJ256DA210 Microcontroller

At the heart of the PIC24FJ256DA210 Development Board is the PIC24FJ256DA210 

microcontroller. This microcontroller comes with a 16-bit core along with integrated 

graphics controller, as well as a wide range of peripherals.

The graphics controller is capable of running TFT, MSTN and CSTN display panels with 

resolution of up to QVGA (320x240) or WQVGA (480x272) at color depths of 16 bits 

per pixel (bpp), and VGA (640x480) running at 8 bpp. QVGA resolution can be run with 

the microcontroller’s internal 96 Kbyte of RAM at 8 bpp. Refer to the 

“PIC24FJ256DA210 Family Data Sheet” (DS39969) for details.

1.2.2 Graphics Interface

The development board uses Microchip’s standardized 64-pin edge connector to 

interface with compatible display boards. Both TFT and STN display boards can be 

accommodated, as well as many forms of resistive touch screen interfaces. Please 

refer to Section 4.4.4 “Graphics Port” for more details.

1.2.3 USB Options

As part of its standard peripheral set, the PIC24FJ256DA210 microcontroller supports 

full-speed USB operations with an on-chip controller and bus transceiver. In addition to 

Device mode operations, the USB controller supports Host and On-The-Go (dual-role) 

modes. The appropriate separate receptacles are provided for the required cable for 

each mode. Note, however, that only one of the USB modes can be active at any time.

1.2.4 Peripheral Options

Beyond the graphics and USB interfaces, the development board is equipped with an 

extensive set of additional features for hardware application development. 

User-defined push button switches, CTMU-based touch sensors, LEDs, serial commu-

nications, and several varieties of external memory are provided to give the developer 

a full range of hardware options. Please refer to Chapter 4. “Development Board 

Hardware” for a complete discussion.

1.2.5 PICtail Plus Connector 

The PICtail Plus connector makes it possible to connect to a range of PICtail Plus 

Daughter Boards, thus adding new functionality to an application under development. 

The connector can be configured for different signal routings to accommodate different 

daughter boards. Please refer to Section 4.4.6 “PICtail™ Plus Card Modular Expan-

sion Connector” for more information.

1.3 POWER REQUIREMENTS

The PIC24FJ256DA210 Development Board can be powered from an external power 

supply, or by applying power directly to test points on the board itself. For simplicity, an 

unregulated 9V power supply is recommended (such as Microchip part number 

AC162039). 

Care must be observed when connecting customized displays. The on-board regula-

tors can supply up to 800 mA current combined. A separate external power supply may 

be needed for bigger displays. Please refer the chosen display panel power 

requirements for details.
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1.4 COMPANION DISPLAY BOARDS

The PIC24FJ256DA210 Development Board is compatible with all of the graphic dis-

play panels shown in Figure 1-3. The demo code that is pre-programmed onto the 

development board is designed to work with the Graphics Display Truly 3.2” 240x320 

Board. The Graphics Display Prototype Board (AC164139) can be used to connect a 

different display panel.

The development board has been designed to be compatible with any future Microchip 

display panel products. Compatible display panels will have a 64-pin edge connector 

that matches the RGB Display Connector (V1). The most current list of display panels 

is available at the Microchip web site.

FIGURE 1-3: MICROCHIP GRAPHIC DISPLAY BOARDS

Graphics Display Truly 3.2” 240x320 

Board (AC164127-4)

Graphics Display Powertip 4.3” 

480x272 Board (AC164127-6)

Graphics Display Prototype Board 

(AC164139)
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1.5 TYPICAL DEVELOPMENT BOARD CONFIGURATIONS

The typical connections to use the development board as shipped from the factory are 

shown in Figure 1-4. To run the pre-programmed demo application:

1. Connect the Truly 3.2” Display Board display into Display Connector V1 (depend-

ing on the development board kit ordered, this may or may not be included with 

the development board)

2. Plug a 9V power supply into J1

To program the board for application development, use one of the two programming 

ports provided:

• J10, a 6-wire RJ-11 jack (for use with MPLAB ICD 3 and MPLAB REAL ICE 

programmers)

• J9, a 6-pin riser (for use with the PICkit 3 programmer)

See Section 4.3.5 “Programming and Debugging Interface” for additional details 

on the programming ports.

FIGURE 1-4: TYPICAL BOARD CONFIGURATION

1.6 DEVELOPMENT BOARD DEMONSTRATION PROGRAMS

The development board is pre-programmed with a demo application designed for the 

Truly 3.2” Display Board. The application automatically runs when power is applied to 

the board, and shows various Microchip Application Libraries integrated into a single 

application. The demo is described in more detail in Chapter 2. “The Demonstration 

Application”.

The application can be reconfigured to run on other display panels. To do this, the 

board must be reprogrammed with the proper HEX file. For directions on reprogram-

ming the development board, see Section Chapter 3. “Programming and Debug-

ging the Board”. 

Additional demonstration programs are provided with the Microchip Graphics Library, 

discussed in the following section. Refer to the Graphics Library Help file for details on 

how to download and run the additional demo applications. 

9V Power Supply (AC162039)

MPLAB® ICD3 Programmer/Debugger

or MPLAB REAL ICE™ In-Circuit Emulator

PICkit™ 3 Programmer

PIC24FJ256DA210 Development Board Truly 3.2” Display

(AC164127-4)

OR
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1.7 ADDITIONAL SOFTWARE FOR APPLICATION DEVELOPMENT 

The demo application that ships with the PIC24FJ256DA210 Development Board only 

demonstrates part of the microcontroller’s capabilities. To take full advantage of the 

microcontroller and the development platform, download and install these software 

tools from the Microchip web site (if you don’t already have them):

• A Microchip development environment, such as the latest version of MPLAB IDE

• A C compiler for PIC24 microcontrollers, such as the MPLAB C30 compiler

• One or more of the specialized Microchip Application Libraries

1.7.1 The Microchip Application Libraries

Microchip Application Libraries (MALs) provide developers the ability to quickly develop 

applications for their products. MALs contain different libraries and stacks supporting 

connectivity, communication interfacing and user interfaces. 

For example, using the Microchip Graphics Library provides ready-made library objects 

and drivers. Adding connectivity to applications is simplified with the MCHPFSUSB 

Library (full-speed USB) and/or the Microchip TCP/IP Stack. All of these stacks and 

libraries also come with their own demo software and examples, aiding users on how 

to integrate these software components into their applications.

Some of the available Application Libraries that will be useful in developing applications 

for the development board include:

• Microchip Graphics Library

• MCHPFSUSB Library 

• mTouch™ Capacitive Library

• Microchip Memory Disk Drive (MDD) File System Interface Library

• Microchip TCP/IP Stack (with the addition of optional hardware)

Refer to the individual application library web page and documentation for details.
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Chapter 2.  The Demonstration Application

2.1 INTRODUCTION

This chapter provides a brief overview of the pre-programmed graphics demonstration 

application that is provided with the PIC24FJ256DA210 Development Board.

2.2 ABOUT THE APPLICATION

The pre-programmed demonstration application has been designed as a showcase for 

the PIC24FJ256DA210 microcontroller. The full-color graphics and resistive 

touch-screen management are all handled on-chip using the microcontroller. Only a 

subset of the development board’s other interactive features are demonstrated in this 

application.

The demonstration runs from two main menu screens (Figure 2-1 and Figure 2-2), with 

Figure 2-1 appearing on power-up as the default screen. Navigation between the two 

menu screens is done with the arrows in the screen’s lower right corner.

A total of 10 interactive demos are provided in the application. Touching the appropriate 

icon invokes that demo. Touching the “Demo” button in the lower left of either menu 

screen runs a continuous loop of several of the demos. Touching “Exit”, generally in the 

lower left of any of the demos, returns to the menu screen.

FIGURE 2-1: DEMO APPLICATION, FIRST MENU SCREEN

The demos available on the first screen are:

• Lighting: this demonstrates a lighting control terminal application. Using the touch 

screen, sliders and buttons are provided to vary the red, green and blue lighting 

colors. 
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• Language: this shows how multiple languages can be integrated into one applica-

tion. Text examples in Roman, Cyrillic, simplified Chinese, Japanese and Korean 

alphabets are shown.

• Game: this is a simple, interactive adaptation of a “snake” video game. Its 

operation is self-explanatory.

• Animation: this shows animation of stored graphics, along with image scaling and 

interactivity.

• Drawing: this demo implements free-hand drawing with a selectable color palette 

using the touch screen.

• ECG: this simulates an electrocardiogram display, demonstrating how analog data 

can be used to produce a graphic output. The “Ext” option switches between the 

fixed ECG display and a graphing display based on the potentiometer’s position.

FIGURE 2-2: DEMO APPLICATION, SECOND MENU SCREEN

The demos available from the second screen are:

• Clock: this is a simple numeric date and time display, based on the 

microcontroller’s RTCC.

• Graph Demo: this demo uses the Chart widget from the Microchip Graphics 

Library to generate a wide range of bar and pie charts based on a fixed set of 

data.

• External Flash: this demo shows images or pictures stored in the on-board Flash 

memory.

• Thumb Drive: this uses the USB Host interface to read a thumb drive connected to 

J4 and scan it for graphics files (JPEG or BMP formats only). The application then 

produces a directory of graphics images, and displays the corresponding file 

when selected.

2.2.1 Other Considerations

The demonstration application described here is the most current version as of the date 

of original publication of the user’s guide. Microchip Technology reserves the right to 

update this application and its appearance in future releases of the development board 

kit.



PIC24FJ256DA210

DEVELOPMENT BOARD

USER’S GUIDE

 2010 Microchip Technology Inc. DS51911A-page 19

Chapter 3.  Programming and Debugging the Board

3.1 INTRODUCTION

The PIC24FJ256DA210 Development Board may be used with MPLAB IDE, the free 

integrated development environment available on Microchip’s website. MPLAB IDE 

with Microchip’s compatible programming/debugging hardware allows the develop-

ment board to be programmed and/or debugged.

For more information on how to use the MPLAB IDE, please refer to the following 

documentation:

• MPLAB IDE User’s Guide (DS51519)

• MPLAB IDE Quick Start Guide (DS51281)

• MPLAB IDE Online Help

This chapter includes the following:

• Tutorial Overview

• Loading the Project

• Building the Code

• Programming the PIC24FJ256DA210

• Running the Code

• Debugging the Code

3.2 TUTORIAL OVERVIEW

Creating projects with the Microchip Graphics Library requires that a number of files be 

included in the project. It is much more efficient to start a new project based on an exist-

ing demo application release with the Microchip Graphics Library. The tutorial in this 

chapter uses that route to guide development of new applications. All demo 

applications are written in C for MPLAB C30.

The Demonstration Applications are provided with the Microchip Applications Library 

downloadable from http://www.microchip.com/mal. When installed in a specified path 
(for example,C:\Microchip Solutions\), the help file Graphics Library 
Help.chm is located in the path C:\Microchip Solutions\Micro-
chip\Help\Graphics Library Help.chm. The help file contains the Graphics 

Library release notes and description of the API. It also contains useful information on 

the demo applications that can run on the development board.

Note: This tutorial was developed using MPLAB IDE v8.40 and MPLAB C30 

Compiler v3.30 as the software tools, and the Microchip Graphics Applica-

tions Library v2.10. Before proceeding, verify that you have at least these 

revision levels.
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Upon completing this tutorial, you should be able to:

• Load an existing project in MPLAB IDE

• Assemble and link the loaded project

• Debug the loaded project

• Program the PIC24FJ256DA210 with MPLAB REAL ICE in-circuit emulator or 

MPLAB ICD 3.

3.3 LOADING THE PROJECT

After installing the Microchip Graphics Library and the Demo Applications that are 

released with the library, load one of the demo applications to MPLAB IDE:

1. Launch MPLAB IDE.

2. Close any workspace that might be open (File > Close Workspace).

3. From the Project menu, select Open.

4. Browse through the directories to get to one of the several demo applications. The 

factory pre-programmed application is located in the path: C:\Microchip 
Solutions\Graphics MultiApp Demo\GMAP USB Demo PIC24.mcp. 

Click Open.

FIGURE 3-1: LOADING THE PROJECT

5. From the Configure menu, choose Select Device.

6. From the Device drop down list, select “PIC24FJ256DA210” (Figure 3-2). Click 

OK to select the device. The loaded project will be set to use MPLAB C30 compiler.
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FIGURE 3-2: SET DEVICE

7. Before you build the project, verify that the display panel to be used is the same 

one included in the code project:

a) On the Project Window select and open the file HardwareProfile.h. 

(Figure 3-3).

b) Select the appropriate header file for the display board to be used. Refer to 

the Graphics Library help file for more information on selecting the hardware 

profile. Refer to the “Demo Compatibility Guide” under the “Demo Projects” 

section.

FIGURE 3-3: SET CORRECT DISPLAY BOARD
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3.4 BUILDING THE CODE

For the loaded project, building the code consists of compiling the source files to create 

an object file, GMAP USB Demo PIC24.o, then linking the object file to create the out-

put files GMAP USB Demo PIC24.hex and GMAP USB Demo PIC24.cof. The HEX 

file contains the data necessary to program the device, and the .cof file contains 

additional information that lets you debug the code at the source code level.

3.4.1 Verifying the Compiler Path

Before building the project, check that the path of the MPLAB C30 compiler is set to the 

correct path. The path must be consistent with the location of the compiler when you 

installed it.

1. At the Project menu, click on Select Language Tool Suite… . This opens the 

Select Language Toolsuite dialog (Figure 3-4).

2. Verify that the C30 Toolsuite is selected in the Active Toolsuite list. In the 

Toolsuite Contents list, select each item, then verify the path for that item in the 

Location box. If necessary, modify the path by clicking on Browse, then 

browsing to and selecting the correct location in the dialog that follows.

3. After verifying and/or modifying the paths, click OK to exit.

FIGURE 3-4: SELECT LANGUAGE TOOLSUITE

3.4.2 Building the Project

Before building the project, set the build for a release version. From the menu bar of 

the main MPLAB IDE window, select Project  > Build Configuration, then select 

Release.

To build the project in the main MPLAB IDE window, select Project > Make. The Build 

Output window appears (Figure 3-5). 

Observe the progress of the build. When the “BUILD SUCCEEDED” message displays, 

you are ready to program the device. 
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FIGURE 3-5: BUILD OUTPUT

3.5 PROGRAMMING THE PIC24FJ256DA210

Programming the PIC24FJ256DA210 is possible through any one of the following 

development hardware:

• MPLAB REAL ICE in-circuit emulator

• MPLAB ICD 2 or MPLAB ICD 3

• PICkit 3

• The MPLAB PM3 Universal Device Programmer

For this example, MPLAB REAL ICE in-circuit emulator is assumed to be used.

3.5.1 Set Up the Device Configuration

The device configuration for the PIC24F devices can be set by two methods:

• Using configuration macros in the source code

• Using the Configuration Bits window in MPLAB IDE

To display the Configuration Bits window, select Configure > Configuration Bits from the 

menu bar (Figure 3-6). 

All demos that come with the Microchip Application Libraries include the configuration 

macros in the code. It is recommended to use these configuration settings in the code. 

To do this:

1. Open the Configuration Bits window. 

2. Select the check box Configuration Bits set in code, located at the top of the 

window, to enable the use of the configuration in code.

For building applications that do not include configuration macros, it is possible to set 

the device configuration by using the Configuration Bits window. To do this:

1. Open the Configuration Bits window.

2. Set the Configuration bits by clicking on each line item and selecting an option 

from the drop-down menu that appears. The Configuration bits for the PIC24F 

device on the PIC24FJ256DA210 Development Board should be set as shown 

in Figure 3-6.
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FIGURE 3-6: PIC24FJ256DA210 DEVELOPMENT BOARD 

CONFIGURATION BITS

3.5.2 Connect and Enable MPLAB REAL ICE In-Circuit Emulator

1. Connect the MPLAB REAL ICE in-circuit emulator module to the PC with the 

USB cable.

2. Connect the MPLAB REAL ICE in-circuit emulator to the PIC24FJ256DA210 

Development Board with the short RJ-11 cable.

3. Apply power to the development board.

4. From the Debugger menu, choose Select Tool > REAL ICE to set MPLAB REAL 

ICE in-circuit emulator as the debug tool in MPLAB IDE. 

Once selected, MPLAB IDE will connect to the MPLAB REAL ICE in-circuit emulator 

and report that it has detected the module (Figure 3-7). Then it connects to the MPLAB 

REAL ICE in-circuit emulator verifying the firmware loaded on the module is appropri-

ate for the selected device (PIC24FJ256DA210). If not, it will load the necessary firm-

ware. Once the firmware is verified to be correct it connects to the development board 

and determines if the target device (i.e., the PIC24FJ256DA210) is present or not.

Note: Do not use the Configuration Bits window to set device configuration if con-

figuration macros are already used in the source code. To do this, check the 

“Configuration Bits set in code” checkbox at the top of the Configuration bits 

window. Refer to the “MPLAB IDE Simulator, Editor User’s Guide” 

(DS51025) for additional information.

Note: Upon first connection to the PIC24FJ256DA210 Development Board, 

MPLAB IDE may need to download new firmware. Allow it to do so. If any 

errors are shown, double click the error message to get more information.
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FIGURE 3-7: ENABLING MPLAB® REAL ICE™ IN-CIRCUIT EMULATOR

3.5.3 Program the Device

From the Debugger menu, select Program to program the part. The Output window 

(Figure 3-8) displays the program steps as they occur.

Observe the results of the programming. When the “Programming/Verify complete” 

message appears, the device is programmed and ready to run.

FIGURE 3-8: PROGRAMMING THE DEVICE
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